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Introduction

This tutorial shows you how to use the ArcMap module to create a simple map. ArcMap is one of the modules
in ArcGIS Desktop. You use ArcMap to create maps, query data, perform analysis, and most of the other basic
GIS operations. ArcMap is the module that you will use most frequently. This tutorial may take 3-4 hours to
complete.

This tutorial is written to be done in the Tisch DatalLab or another Tufts campus computer lab.

Note for Mugar Lab Users: Mapping a Network Drive in Windows
If you are in the Datalab, the GIS data server that we need, “M”, is already mapped. To use the Datalab drives
from Mugar Lab, you must first map the network drive in Windows.

1. Assuming you are using Windows 10, open a file explorer window, on the left side of the screen right
click on “This PC” and then select “Map Network Drive.”

2. Inthe drop down menu labeled Drive: choose the “M” as the drive letter. If the letter “M” is not
available, select an available drive letter and remember what you chose.
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3. Inthe Folder: drop down menu manually enter (or copy and paste) :
\\rstorel.uit.tufts.edu\tts_rsch_gis_dataset02$. Press Finish.

Creating a Map with ArcMap
You will now learn the basics of using GIS data to explore an area and create a map. Your efforts will be
focused on India.

Starting ArcMap, opening ArcCatalog, and adding data layers
To start ArcMap, choose Start = All Programs = GIS Applications = ArcGIS = ArcMap 10.5.1

1. When the first dialog box comes up, highlight the option to start with a new blank map and press OK.

,
@ wir cetrgses L

Open existing map or make r%ap using a template

[=]- Existing Maps My Ternplates
Recent
i i.Browse re...

o :

H n
My Templates
=) Templates

[=)- Standard Page Sizes
i Architectural Pac
150 {A) Page Siz Blank Map \
- Morth American |

2. Go to Customize — click on Toolbar, and make sure that Standard and Tools are visible (have check

marks next to them).

3. On the left side of the screen, you should see your Table of Contents area - right now it should only say
"Layers". If you do not see this separate area, select Windows = Table of Contents.

4. Use the mouse to pass over each tool and see what it does.

5. Choose Windows = Catalog to bring up the ArcCatalog window — ArcCatalog is like a file manager for
GIS data — we’ll talk more about it in the class.

Windows | Help

Chverview

Magnifier

Viewer

Table Of Contents

|[;] Catalog |

Search Ctpl=F
Catalog

Image Analysis

Open the Catalog window to
access and manage your data.

@J Press F1 for more help.
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6. Click on the Auto-Hide icon (thumb-tack) to keep this Window visible.

i Catalog R x
c oty @ HEH- 8
Location: @ Home - Documents \AroGIS -

B [ Home - Docurments\ArcGIS
£ addlns
= Packages
3 Web Maps
L@ Default.gdb
e Toolbox.thx
EH Folder Connections

7. Click the Connect to Folder icon. This allows you to access folders.

Catalog ax
vl @ | &4l

Location: Home - Documents\ArcGIS V.

= [ Home - Documents\ArcGIS \
# EJ AddIns

# | Default.gdb
£} ° Toolbox.tbx
[£3] Folder Connections
# [l Toolboxes
@ [{J Database Servers
& (3l Database Connections
& 3 GIS Servers
& [ My Hosted Services
[# [ Ready-To-Use Services
[# &3 Interoperability Connections
# (%% Workflow Manager Databases

o

o)

8. Under This PC, highlight the (M:) drive and click OK. If you are in the Datalab, this drive will already be
connected.

Connect To Folder X

Choose the folder to which you want to connect:

B Desktop
[& OneDrive
& villalba, Savannah-Nicole
v [ This PC
B 3D Objects
I Desktop
| Documents
& Downloads
D Music
&= Pictures
B Videos
e Windows (C9)
== svillaD1 (\\rstore2\gisusersS) (H:)
v == tis_rsch_gis_dataset02$ (\\rstorel) (M:)
Campus
City
Continent
Country
County
EnterpriseGIS
State
World
= gisprojects$ (\\rstore2) (5:)
1 Libraries
i Network

Folder: [ M:\

Make New Folder Cancel
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9. Ifit does not already exist, make a folder connection to your H: Drive as well - you will store your map
file there later.

10. Using your new M drive folder connection, navigate to M: = World - ESRI DataMaps10 - World -
Data. Click once on each .sdc file to highlight it and drag the following data layers into the main ArcMap
window (one at a time):

a. Cities.sdc
b. Country.sdc
c. Lakes.sdc
d. Drainage.sdc
e. Rivers.sdc
Catalog 2 x
ero4@| E e
Location: [ data -
=R I_-|ome- Documents\ArcGIS &
# ] AddIns

# | Default.gdb
£} e Toolbox.tbx
= 3 Folder Connections
B £ M\ sfiemm——
# £ Campus
@ B3 City
# (3 Continent
& [ Country
| E3 County
# 7] State —
= E3 World
= E3 bcw
= [ ESRIDataMaps10
& ] europe
= E world
& 7 background
® 5
s ﬁ FUTTITT.SUT
& [P admin_In.sdc
& [P airports.sdc
@ [P cities.sdc
& [P continent.sdc
J ﬁ] contours.sdc
country.sdc
country_In.sdc
drainage.sdc
dtl_cntry.sdc
dtl_cntry_In.sdc
gaz.sdc
geogrid.sdc
hydrolines.sdc
hydropolys.sdc

Iabar cdr

< 1 | »

m

=

+ H>

FHFHFEEEHFB®H

F@@@@@@@@L‘E

l+

Bl

11. Uncheck lakes and drainage in the Table of Contents. You can do so by clicking once on the box, located
to the left of the file name.
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= =7 lLayers
= cities

L

= [ drainage

= [ lakes
[

= country
=

12. Now you should have just the rivers, cities, and countries (country) drawn on the map.

Getting Around the Map

1.

=

Note: When using the zoom tool, you can click and drag a box around the area that you would like to
zoom in to.

Zoom into a part of Africa using the Zoom In tool.

®|E ™
Use the Zoom In, Zoom Out, and Pan ( \)‘ =S ) tools to move around the map.

o

Note: In ArcGlIS, you can place the cursor over each tool in the menu without clicking to see a
description of what it does.

Use the Zoom to Full Extent tool ( ) to go back to the full view which encompasses all the data.

Try clicking on the Identify icon ( i ) and then click on countries, rivers, or lakes. The Identify tool
brings up information from the “attribute table” for each feature you click on.

Can you find Gulu, Uganda?

Hint: Choose the Find ( H.) tool, click on the features tab and in Find, type in Gulu and click find. Then
right-click on one of the results below, and choose Pan to or Flash.

QAFOE I« -0/ 8@ /B uRleS TR,
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10.
11.

12.

B Find X nL
w *
Features |opcations Linear Referencing
- : *
Find: | Gulu i | Stop o .
L
In: | <Visible layers> ﬂ New Search " ¢

Find features that are similar to or contain the search string

Search: A ©
(@ Al fields ] ©
3
O1n field: ¢
ObjectiD
\d ‘ -
Cancel ',
Right-click a row to show context menu. 2
Value Layer Field |
Gulu cities
# Zoom To *
byl PanTo

[HL} Create Bookmark

- o @ Identify..
E Féﬂ Select

1 © Unselect

One object found

® L_tl Add to My Places
FJ Manage My Places...

s Add as Stop to Find Route
%" Add as Barrier to Find Route

Add as Metwork Analysis Object
Mowve Metwork Analysis Object

Right-click on the rivers layer in the Table of Contents (be sure you right-click on the actual name and
not the symbol) and then click on Label Features — this will label the rivers.

Turn on the lakes layer. If you don’t see the lakes, they may be under another layer. You can make
them draw on top by clicking on the lakes layer in the Table of Contents, holding down the left mouse
button, and dragging it up above other layers. This is how you move layers around on a map. *Note: if
you still cannot see the lakes because they are the same color, leave it; you will learn how to change
layer colors in the next section and should change the lake color then.

Turn the lakes layer off again for now.

When you are done looking around, click on the full extent icon ( G) in the Tools menu.

Now choose File 2 Save. On the Left hand side of the screen, click Computer.

Double click on your H Drive (your folder for personal data storage). Within this folder, create a new
folder ( : ) called ArcGISBasics. Double click on this new folder once it is created.

Name the map file basemapl.mxd. This action creates a map file (.mxd). A map file is a very small file
that contains pointers to your data sets (it does not actually save the datasets) and remembers what
you had displayed in your session. If you quit ArcMap at this point, you can reopen this map file and
everything will be as you left it; the same data layers will be there and it will have the same view of the
data. Thus, map files are easy ways to save work.
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13.
14.

15.
16.

But beware — map files do not actually contain data layers, they only have pointers to where the data
is saved. If you copied your basemapl.mxd file and tried to open it on a home computer without also
saving the data layers, the ArcMap session would start and list the data in the table of contents, but
nothing would appear because it would not be able to find the where the data is stored. A little red
exclamation point would appear in the table of contents, informing you that it has lost the connection to
the data.

Save your map file frequently and always save at the end of a session. ArcMap likes to crash!

Navigate to the M:\Country\India\India Base Map folder and drag all the shapefiles in that folder into
the ArcMap window.
= B3 Country
# £ Cambodia
+ £ China
= £ India
= £ IndiaBaseMap
# £ Description
[E]) DISTRICT.shp
(=) RAILWAY.shp
[=J ROAD.shp
|E) STATE.shp
|EJ) SUB_DISTRICT shp
[%) TOWN.shp

Again, the map will be messy. Zoom into India so that it fills the map.

You can group the India data layers all together. If they are no longer all highlighted, hold the CTRL key
and click on each one in turn to highlight them. When they are all highlighted, right-click on one of them
and choose Group as shown below:

=) = Layers
= TOWN
*

= cities &
®
= RAILWAY

> v 8

- &

- [ drainage

7 MEQIE & copy
[

¥ Remove
= STATE [
O |§\_} Group
= @ EI
O Turn Off
= [ lakes

O ";’ Create Layer Package...
= rivers | (> Zoom To Layers

Visible Scale Range 3

[/

= cntry(
O

17. Rename the “New Group Layer” to India by right clicking the new group = properties, and entering the

new name.

18. Perform the same grouping on the World data so that it is in its own group as shown below. If you click

on the first and last datasets, while holding shift, all layers will get highlighted and you can group them
faster.

19. Turn off the World data group.
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B = layers
= India
o @ TOWN
*
o [ RAILWAY

= @ ROAD

= @ DISTRICT
[}
o W STATE

|
=] SUB_DISTRICT

[
Cu] orid|
= cities
+

= O drainage

= rivers

= lakes
|

= cntry06
|

REMINDER: Save your map file frequently and always save it at the end of a session!

Setting a Coordinate System for the Data Frame

The rest of this tutorial focuses on India, so we are going to set a coordinate system that better maps India. This
will also ensure that any spatial queries you do will perform correctly. We will talk a lot more about projections
in a few weeks.

1. Click on the View menu and choose Data Frame Properties.
2. Click on the Coordinate System tab.

3. Inthe coordinate system dialog box, you will see information in the bottom panel for the current
coordinate system (GCS_WGS_1984). We want to change this.

4. Scroll down and click on Projected Coordinate Systems, then UTM then on WGS 1984, then Northern
Hemisphere, and finally on WGS 1984 UTM Zone 44N as shown below and then OK:



Tufts Data Lab

Data Frame Properties L\\) X
Feature Cache Annotation Groups Extent Indicators Frame Size and Position
General Data Frame Coordinate System llumination Grids
-’ - | |T*f'|3e here to search v| Q) = | C‘J v 5

240 of 6040 items shown

() WGS 1984 UTM Zone 40N "
() WGS 1984 UTM Zone 41N
) WGS 1984 UTM Zone 42N
€ WGS 19284 UTM Zone 43N
£ WGS 1984 UTM Zone 44N
2} WGS 1984 UTM Zone 45N
) WGS 1984 UTM Zone 46N
;ga WGS 1924 UTM Zone 47N

Current coordinate system:

WGS_1984_UTM_Zone_44N ~
WKID: 32694 Authority: EPSG

Projection: Transverse_Mercator
False_Easting: 500000.0
False_Morthing: 0.0
Central_Meridian: 81.0
Scale_Factor: 0.9996
Latitude_Of Origin: 0.0

Linear Unit: Meter (1.0)

Transformations...

Cancel Apply

5. Turn on the world data and zoom to the full extent (Q ). You will see that this severely distorts the rest

of the world. But it’s a great way to map India!

6. Zoom back to India when you’re ready and again turn off the world data.

7. To clean up the map, uncheck all the layers except for the railway, district, and state layers within the

India Group.

Defining the General and Symbology Properties for a Layer

In this section of the tutorial, you will learn how to organize your data layers' properties to start bringing some

coherence to the map. You will also learn how to color the data layers to start making a more interesting and

readable map.

Assigning Proper Layer Names
First, you need to give the layers better names than what they have (e.g., SUB_DISTRICT = "Sub-district").

1. Right click on the SUB_DISTRICT layer and choose Properties (alternatively, you can click twice slowly on

the data layer name or press the F2 button).

2. When you see the Properties dialog box, click on the General tab and for layer name, type in Sub-district

instead of SUB_DISTRICT. Press OK when finished.

Note: this does not change the name of the original data set saved in the M drive - it only changes the

name as it appears in this Map Session (.mxd) of ArcMap and as it will appear on your final map.
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3. Rename all the layers so they are not in all caps. In the future, points will be deducted on assignments
for having non-standard “data speak” names like "cntry08" appearing in your map.

Assigning Proper Colors

Your map would be a lot better if the district layer were not blocking the state layer, etc. We want the State

boundaries to show up on top of the District boundaries.

1. Right-click on the State layer and bring up the Properties dialog box again.

2. Click on the Symbology tab.

3. To change the color of the layer, click on the colored box under Symbol - this should bring up the Symbol

Selector box.

Show:

Layer Properties

Groeral  Source  Selection Display Symbology Fields  Definion Query  Labels Joins & Relates  Time  HTML Popup

Features
Categories
Quantities
Charts

- Single symbol

Mulliple Altributes |:|

Draw all features using the same symbol .

Symbol

Legend

N/ =R Descrption...

Additional description appearing next to the symbol in your map's legend

Label appearing next to the symbal in table of contents: l:l

Impaort...

Advapced =

Cancel Apply

4. Click on the small colored box next to Fill Color, to see colors to choose from. Choose No color for the

states’ fill.

General  Sou ML Popup
Show
Features Type here to search vl VN EE +  Current Symbol
. Single: sy1 .
Categories Search: (®) All Styles (O Referenced Styles
Quantities | [ gqg)
Charts
Multiple Att
Green Blue Sun
Fill Color: -
l:‘ l:‘ Outiine Width: I < Mo Coler
\QL";J'(}?- 3 Hollow Rose Qutiine Color:
g

[]

[ o £ o
C

Beige Olive

]

Green

B
[ o[

Edit Symbt

Save As...

More Colors...
Style Referer.
OK Cancel
OK Cancel Apply

10
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5. Make the outline width 2.00.

6. Press OK when you are finished, and OK again to return to your map.

7. Drag the State layer to the top of the India group in Table of Contents. Now that it is hollow you can see

the layers underneath.

8. Color the District layer beige and give it a 1.0 gray outline width as shown.

2 Curr% Symbaol

9. Using what you have learned, give appropriate colors to your other layers.

10. When finished, choose File = Save again. Now your basemap1.mxd file will remember all the colors
and names you assigned. It’s starting to look better...

Drawing a Layer Based on an Attribute Value

Fill Color:

Outline Width: |1

-
Iy
L3

Outline Color: . =

Ml

Some of your layers would look better if you could distinguish between types of features within the same layer.
The State layer, for example, shows India’s state boundaries but doesn’t give us more information when drawn

with a single color. You can use an attribute field to symbolize your data to reflect the field values.
1. [Ifit’s not already on, turn on the State layer.

2. Right-click on the State layer and choose Open Attribute Table:

5 & Layers

BI:IEE

= M Ing X

Copy
Remove

BE

Open Attribute Table

]

S

S

S

= 0w
=M

=

Joins and Relates

» Zoom To Layer

Visible Scale Range
Use Symbaol Levels
Selection

Label Features

Edit Features

11
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Before we proceed, you need to know what the items in the attribute tables for the STATE, DISTRICT,
and TOWN attribute tables mean. The attribute table contains relevant information about the states,

but the field headings (aka column headings) are sometimes hard to understand.

Metadata is documentation explaining what is in your attribute table and gives a definition for each of
the field headings. To know what attribute fields are appropriate for use in symbolizing your data, you
must be familiar with the attribute table structure, its fields, and the possible values of each significant

field.

3. Inthe India_Base_Map WINDOWS folder (the regular folder that you get to through “computer”),
there is a subfolder called DESCRIPTION. Open up this folder using your Windows File Manager (not
ArcCatalog). Go to This PC\M:\Country\India\IndiaBaseMap\Description, and take a look at the

STATE.PDF to see what the abbreviations in the attribute table columns mean.

[ || = | Description
Home are

» This PC

€ - -

5 Quick access
[ Desktop
J Downloads
[ Documents
&) Pictures

‘i Local Disk (C3)
[ OneDrive

[ This PC
[ Deskiop
5 Documents
4 Downloads
D Music
&) Pictures

B videos

‘i, Local Disk (C:)

=¥ Network

= dbaham01 (\\rstore
= tts_rsch_gis._dataset

= gisprojects$ (\irstor

Gitems  State:{@) Online

View

Name

" District.pdf

= Railway.pdf
= Road.pdf

" State.pdf

"= Sub-district.pdf
= Town.pdf

Date madified Type

be Acrobat D...
Acrobat D...
crobat D...

be Acrobat D...
Adobe Acrobat D...

> tts_rsch_gis_dataset025 (\vrstorel) (M) > Country > India > IndisBaseMap > Description

A0 KB
2TKB
2TKE
41 KB
43 KB
38KB

v|®/| | Search Description

Select 5 file to preview.

Let’s say we wanted to visualize the population of cultivators. We see that the field name for this data item is
TOT_CULT and that the number of Total Workers is in the field, TOT_W.

1. Right click on the State layer, and click Properties.

2. Click on the Symbology tab, and select Quantities (on the left), then Graduated Colors.

3. Change the drop down next to the Value field to be TOT_CULT, as you see below:

12
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Layer Properties *
General Source  Selection Display Symbology Fields  Definition Query Labels  Joins & Relates Time  HTML Popup
Show:
Feat Draw guantities using color to show values. Import...
Fields Classification
Quantities Value: none ~ Manual
‘- Graduated colors —_—
Normalization: | |C k= | & Classes: Classfy...
M_ST
Proportional symbols F_ST
i-- Dot density Color Ramp: [ TOT_LIT
M_LIT
N Symbol  Ran| LT Label
Multiple Attributes ymoel Ran TET_ LT =
M_ILLT
F_ILLT
TOT_W
M_W
F_W
TOT_MNW
M_MNW
[ Show class 'II:'E)(;I'L_”;.-(FELB Advanced -
M_AGLB
F_AGLB hd
Cancel Aoply

Notice that the options in the Value dropdown are the field headings you saw in the attribute table.

4. Press OK when finished. The resulting map is interesting. If you can’t see the data, make sure your
“World” group of data is turned off. Now, we see the states with larger numbers of cultivators. What
states have the largest numbers?

Hint: use the Identify tool - @ .
But now we want to map the states by showing the percentage of cultivators out of the total number of

workers. To do this, we need to normalize the data by the Total Workers field.

5. Go back to the State Layer Properties and to the Symbology tab. In the box for Normalization, choose
the field, TOT_W — when you use this Normalize function, it simply divides the top value by the
normalization value to give you a fraction, so in this case Total Cultivators/Total Workers = % of Total
Cultivators out of the working population.

Layer Properties ’

| Generall Sourcel Seleclionl Display| Gymbolagy |Fie\ds I Diefinition Queryl Labels I Jains & Helatesl Time I HT

Shawr:

Features Draw quantities using color to show values.
Categories Fields Clagsification
Quantities Walue: TOT_CULT - Matural Breaks [Jenks)

i Graduated colors
i Graduated symbiols
- Proportional symbols

- Clazges: 6 =

Homalizatior):

i Dt density Color Barmp: _ M
Charts
| || Multiple Attributes Symbol  Range Label

000000000 - 0.057017352 0.000 - 0.05702
0057017353 - (169982462 0.05703 - 01700
0169982463 - (.282915528 01701 - 0.2829

I 0. 252916529 - 0.353955955 0.2430 - 0.3640 &

I 0. 353955955 - 0.541022840 0.3641 - 05410

[ Show class ranges using feature values
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6. Press OK. The resulting map shows the number of cultivators in each state as a fraction of the total
workers (e.g., 0.541022 means 54% of workers are cultivators).

7. Try making the same map (percent of workers who are cultivators) using the District layer instead of
State layer. Compare the two layers. You may have to drag one on top of the other to see them.

GerL\\;al Source Selection Display Symbolody Felds Defintion Query Labels Joins & Relates Time  HTML Popup
|

| Show:

! [ Feat Draw quantities using coler to show values. Import...
! | Categories Fields Classification
| | Quantities Value: TOT_CULT w Matural Breaks (Jenks)

-~ Graduated colors 7

- Graduated symbols Nomnalization: | M_CULT ~ Classes Classify

-~ Proportional symbols

- Dot density Color Ramp: - ~

Charts

Muttiple Attributes Symbol  Range Label

1.08920583 - 114328305 1.089-1.143
1.14328306 - 1.27963054 1.144-1.280

1.27963055 - 146753634 1.281-1.468 |

I 1 46755655 - 1.73733971 1.469-1.737 |
x| [ 173733972 - 2.01062329 1.738-2011

[ Show class ranges using feature values Advanced ~
0K Cancel Apply

How would you create a population density map for the District layer (total population divided by area)?

8.

Note: The Tot_Area column is the square kilometers of the district. The State and Sub_district layers do not
have a Tot_Area column!

Try creating other maps based on the attribute table values by State, District, or Sub-District — the field
(column) names in the attribute table are the same for all of these. Save your map file when finished.

Note: If you want to keep a layer symbolized one way (e.g., percent cultivators for each state) and also have
another map by state (e.g., percent illiterate), you can add the State layer again from ArcCatalog and start
fresh on the new layer.

Assign a proper title to the layers you symbolize. Change the heading nhame (eg. TOT_CULT/TOT_W) to
Percent of Cultivators. Leave the layer name as District. You can change the heading name by clicking twice
slowly on the heading or by pressing F2 when it is highlighted.

= District
Percent of Cultivators
[10.000 - 0,1400
101401 - 0.2402
[10.2403 - 0.3327
03328 -0.4512
04513 - 0.6988
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Selecting and Mapping the Largest Cities in India
In this section, we’ll use the Town layer which includes all of India’s towns to select and map only the towns that
have a population greater than 1 million people.

1. Turn on (checkmark) the Town layer. Drag Town to the top of the group in the Table of Contents.

2. Right-click on the Town layer and choose Open Attribute Table

able Of Contents nx
< Layers
= India

el T
o |[E Copy

=] Ro| ® Remove

5 ;|§ Open Attribute Table
Joins and Relates

= Su '__L’ Zoom To Layer
[
= Ste

Visible Scale Range

3. Scroll to the right in the table until you see the TOT_POP field:

Table O x
R R i
Town £8
DISTRICT STATE_UT | STATUS C_CODEM TOT_NM_HH [ TOT_POP ] M_POP | F_POP | TOT_L6 | M_L6 | F_L6 | TOT_SC A
Adilabad Andhra Pradesh M 2801000240101000 21288 109529 55641 53388 16285| 8472 7814 12300
Adilabad Andhra Pradesh M 2801004640108000 14283 BBT92 33812 37980 74T 3868 3779 1871
Adilabad Andhra Pradesh M 2201004240103000 132684 66596 33950 32646 7535 3810 arzs 1545¢
Adilabad Andhra Pradesh M 2801004040107000 14543 75254 37794 374580 10666 5438 5228 438¢
Adilabad Andhra Pradesh M 2801001440103000 12170 59734 30435 29298 7189 | 3750| 3439 9541
Adilabad Andhra Pradesh M 2801005040111000 15283 70381 35710 34571 9433 4893| 4540 T5TE
Adilabad Andhra Pradesh M 2801003540106000 7391 41331 21257 20034 7359 | 3817| 3542 458"
Adilabad Andhra Pradesh CcT. 2201001540104000 3837 19330 10059 9271 2587 1340 1247 2507
Nizamabad Andhra Pradesh M 2802001240201000 54167 288722 | 145188 142524 39872 | 20419| 19453 22302
MNizamabad Andhra Pradesh M 2802001440202000 12823 T1520 35154 35356 10282 5301 4531 599¢
Nizamabad Andhra Pradesh M 2802003440203000 12764 54496 32770 37286 8633 | 4385| 4248 422
Karimnagar Andhra Pradesh M 2803000740301000 52838 237686 | 121250( 116436 26633 | 13600| 13033 4669¢
Karimnagar Andhra Pradesh M 2803003540306000 45744 218302 | 111875 106427 26890 | 13520| 13070 2038
Karimnagar Andhra Pradesh M 2203002140304000 17826 85521 43377 42144 10768 8533 8235 6147
Karimnagar Andhra Pradesh M 2803004240307000 14298 65314 32686 32548 2354 4305 4049 311«
Karimnagar Andhra Pradesh M 2803002340305000 11010 54012 27273 26739 Trzg 3930 3798 4127 v
g ; e e T el S S R R
oA 0r h E {0 out of 5161 Selected)
Town

4. Right-click on the Tot_POP field heading and choose Sort Descending.

'—'mﬁ_l:_
‘OT_NM_HH [ TOT_PQ

31223 1595 =  Sort Ascending
14283 85T{=  Sort Descending |
13854 665! :
4543 — Advanced Sorting...
12170 597 Summarize...
15283 7034 ¥ Statistics...
7381 413

5. Now you’re going to manually select all the towns in India with 1 million or greater total population.
Click on the grey area to the left of the first column to select the row. Once you have selected a row,
hold your mouse and drag downwards. The rows below will become highlighted. Continue dragging and
selecting rows until you get to cities below 1 million total population. You will then have all towns in
India with a population of over 1 million selected.
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6. You should have 31 towns selected. It should say “31 out of 5161 Selected” at the bottom of the table

after highlighting the rows:

Table 0O x

. B By 6 x

Town x

———
FID { Shape | TOWN_ID NAME DISTRICT STATE_UT STATUS C_CODE0 TOT_NN ~
2122 | Point 2722001 |Greater Mumbai Mumbai (Suburba | Maharashtra M.Corp.  [2722000042201000 251
625 | Point 70501 | Delhi Municipal Corporation (U) In all 9 dsitricts Delhi M.Corp. 0701000240103000 196
5065 | Point 1917001 |Kolkata Kolkata West Bengal M.Corp. |1817000041701000 82
5053 | Point 3302001 |Chennai Chennai Tamil Nadu M.Corp.  |3302000040201000 96
5050 | Point 2520002 |Bangalore Bangalore Karnataka M.Corp. 2520000042003000 84
5045 | Point 2407001 | A A Gujarat M.Corp. |2407000540710000 72
5060 | Point 2856001 (Hyderabad M.Corp Hyderabad and R [Andhra Pradesh M.Corp.  [2805000040501000 66
5102 | Point 2422014 |Surat Surat ‘Gujarat M.Corp.  [2422000942205000 4
4445 | Point 534007 |Kanpur Kanpur Nagar Uttar Pradesh M.Corp. 0934000243405000 44
5072 | Point 2725017 (Pune Pune Maharashtra M.Corp.  [2725000842508000 55
5043 | Point #12004 [Jaipur Jaipur R M.Corp. |0812000841210000 40
4410 | Point S27005 [Lucknow Lucknow Uttar Pradesh M.Corp. |0827000342705000 39
5069 | Point 2709018 |Nagpur Nagpur Maharazhtra M.Corp. 270900104059153000 40
5061 | Point 2326004 (Indore Indore Madhya Pradesh [M.Corp. |2326000342506000 28
5051 | Point 2332002 |Bhopal Bhopal Madhya Pradesh  (M.Corp. | 2332000243202000 28
5071 | Point 1028011 Patna Patna Bihar M.Corp. |1028000342807000 23
5104 | Point 24158015 |Vadodara ‘adodara Gujarat M.Corp.  [2415000241508000 30
5094 | Point 308005 | Ludhiana Ludhiana Punjab M.Corp. 0309000440901000 26
4858 | Point 915002 |Agra Agra Uttar Pradesh M.Corp. 0915000241504000 19
2123 | Point 2721030 | Thane Thane Maharashtra M.Corp. |2721000942131000 28
2143 | Point 2721009 | Kahyan-Dombivali Thane Maharazhtra M.Corp. 2721001242133000 27
47T | Point 967010 |Varanasi \aranasi Uttar Pradesh M.Corp. 0957000246710000 15
2126 | Point 2720011 |Nashik Nashik Maharashtra M.Corp. |2720001142011000 22
5068 | Point S07010 |Meerut Meerut Uttar Pradesh M.Corp. 0907000340711000 17
5153 | Point 618001 |Faridabad Faridabad Haryana M.Corp. 0513000141502000 21
5077 | Point 2813009 | Vi Wit Andhra Pradesh  (M.Corp. | 2813002741307000 23
4582 | Point 545001 [Allahabad Allahabad Uttar Pradesh M.Corp. |0845000344503000 13
2409 | Point 2725016 | Pimpri Chinchwad Pune Maharashtra M.Corp. |2725000742511000 23
5058 | Point 1916022 |Haora Haora West Bengal M.Crop. 1916000041525000 21
5079 | Point 302002 | Amritsar Amritzar Punjab M.Corp. 0302000340205000 18
718 | Point 2409008 | Rajkot Rajkot Gujarat M.Corp. |2409000640904000 19
4828 | Point 505009 | Ghaziabad Ghaziabad Uttar Pradesh M.Corp. 40912000 17
5129 | Point 2339005 |Jabalpur Jabalpur Madhya Pradesh [M.Corp. |2333000343913000 18
5101 | Point 103003 | Srinagar Srinagar Jammu & Kashmir |M.C. 0103000340302000 13
5124 | Point 2816007 |Viayawada Krizhna Andhra Pradesh M.Corp. 2816002141803000 21
5054 | Pnint 32312013 | Coimbatnre Cnimhatnre Tamil Nadu M Corn 3312000841 243000 e

< >

Town

7. Close the table. You should see the over 1 million towns highlighted in blue on your map.

8. To create a layer with just these large towns, right-click on Town and the choose Data = Export Data (as

shown below):

Table Of Contents

4 X

I SO JO B|qeL

= £ Layers
=] ndia

= @ B
JE]

e 3

Copy
Remove

x

® 1B Open Attribute Table

@

Joins and Relates

®: > Zoom To Layer

@-

Visible Scale Range

R
= _oa Use Symbol Levels
= Rail Selection »
- Label Features
= O Sub 8
o Edit Features 3
= Stats
195 Convert Features to Graphics..
o
o Convert Symbology to Representation...
134 Data b ‘
MG save As Layer File.. Export Data..
0 .
a gst Create Layer Package... Expurr%‘ CAD.
Properties... Expoctiiiata
[10.000 - 0.1400 View Savethis layer's data as a shap:
10,1401 - 0.2402 or geodatabase feature class
[ 0.2403 - 0.3327
B 0.3328 - 0.4512 Export to a SAS data set
N 0.4513 - 0.6988
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9. You'll get a new dialogue box like so. Make sure it says Export Selected features. Click on the folder to
choose where you will save this layer. Navigate to your H drive = ArcGlISBasics and name the new layer
Large_Cities and make sure to save it as a Shapefile. Then press ok. And ok.

kxpor‘t Data X

Export:  |Selected features w

Use the same coordinate system as:
(@) this layer's source data
(O the data frame

the feature dataset you export the data into
{only applies if you export to a feature dataset in a geodatabase)

Cutput feature dass:

H:"ArcG15Basics'\Large_Cities shp | E‘

Cancel

10. Click Yes when asked if you want to add this exported layer to the map.
11. Once added, change the name from Large_Cities to Large Cities (remove the underschore).

12. Drag the Large Cities layer into the India group so that they are at the top of that group. Turn off the
Town layer, so you only see the Large Cities.

13. Click on the Clear Selection icon to turn off your original selected towns. This is located on your Tools
toolbar:

File Edit View Bookmarks Insert Selection Geoprocessing Customize Windows Help
3 = = El B ) &+ 1:131.113679 v o7 Gl & | e s
OROREGI* 23 KI-IOIN @ G322 M58 B

14. To display the large cities with symbols graduated by population size, double-click on the Large Cities
layer to get the layer properties, and then click on the Symbology tab.
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15. Fill out the symbology properties as you see below. You want a map showing Quantities using
Graduated Symbols, using the TOT_POP field as your value:

Layer P&p erties x

General  Source  Selection  Display Symbology Fields  Definition Query Labels  Joins & Relates Time  HTML Popup

Show
Features

Draw quantities using symbol size to show relative values. Impaort...
Figlds Classffication
Quantities Value: I ‘TOT FOP v| I Matural Breaks {Jenks)

i Graduated colors
Teaa Mormalization: | none - Classes |5_VI Classify
i Proportional symbols

Symbol Size from to

Muttiple Attributes

Symbol  Range

®  1003015- 1193512
@ 1193513 - 1506062
. 1506063 - 2702304
. 2702305 - 4572876

Label

1003015 - 1193512
1153513 - 1506062
1506063 - 2702304
2702305 - 4572876

Templzate
-

. 4572877 - 11978450 4572877 - 11978450

‘q\ [[1 Show class ranges using feature values Advanced -

Cancel Aoply

16. Press OK to see the results on the map. What do you see? Do you see any problems in the map?
17. Turn the full Town layer back on.

18. Using the complete Town layer, create a graduated symbol map of total population using the steps
outlined above for Large Cities.

You'll see it’s quite messy when looking at India as a whole, but provides better visual information when
you zoom into one state. Zoom into a state too see what we mean. You might need to turn off the
District Layers to see the State Layer.

To return to your last “extent” or view, press the back button ( - ).

Note: If you want to change the colors of the symbols, in the Symbology properties box, above the symbol
window, click on the Symbol column header and choose Properties for All Symbols, as show below:
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Layer Properties

General Source Selection Display Symbology Fields Defintion Query Labels  Joins & Relates Time  HTML Popup

Show:
Feat Draw quantities using symbol size to show relative values. Import ...
Categories Fields Classification
Quantities Value: |TOT_POP v | Matural Breaks (Jenks)
. Graduated colors .
Gramtsted Spmbols Normalization: |nor‘|e ~ | Classes: Classify...
i Proportional symbols
Charts Symbol Size from: EI tao:
Multiple Attributes Template
lSyrnbc' I.—.____ P o
Flip Symbols
@
@ Properties for Selected Symbol(s)...
@ | Properties for All Symbnls...l N
\F
@ 2702305 - 4572876 2702305 - 4572875
@) ss72e77-t1o7easD 4572877 11978450
[] Show class ranges using feature values Advanced -

Cancel | [ fonly

Note: You can also change the number of “classes” or break values, by changing the box that says Classes.
You can also change the starting/ending size of the symbols in the boxes immediately above the symbol

window, as shown below.

| Lay T&F‘rcpeniea

General Source Selection Display Symbology Fields Defintion Query Labels Joins & Relates Time  HTML Popup

Show:

4572877 - 11972450 4572877 - 11972450

Feat Draw gquantities using symbol size to show relative values. Import...
Categories Fields Classification
Quantities Value: |TOT_POP w | Matural Breaks (Jenks)
i Graduated colors -
Graduated symbols Nomalization: |none V| Classes: Classfy...
Proportional symbols [ ]
Charts Symbal Size frof: EI to:
Multiple Attributes Template
Symbol  Range Label o
|
| e 338-13235M1 338- 133571
|
| @ 133572- 538741 133572 - 558741
. 558742 - 2052066 558742 - 2052066
@ 2052067 - 4572876 2052067 - 4572876

D Show class ranges using feature values Advanced ~

OK Cancel Apply

Save your map file!
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Using the “Select by Attribute” Function

In the last section, we sorted the table by total population to select our largest towns. But there is another way

to query or select the data in ArcMap — we can use a selection query.
1. Turn your Large Cities layer off, but leave Town on.

2. Click on Selection in the Tools menu and then choose Select by Attributes.

Q basemapl.mxd - ArcMap

File Edit View Bookmarks Insert | Selection | Geoprocessing Customize Windows Help

D s B x| o B SelectBy Attributes.. N \It EEEED

@ & Select By Location...

CRCYEE TR Y ! Select By Attributes
Table Of Contents i B Selects features by their attribute
E‘ agE 3 values

= Layers )

= O Large Cities
TOT_POP
< 1003015 - 1193512
& 1193513 - 1508062
. 1506063 - 2702304 Selection Opticns...

Interactive Selection Method b

D) 2702305 - 4572876

. 4572877 - 11978450

3. Follow the steps in the graphic below to add the expression to the query box.

-

Select By Attributes

Layer: % Town
[~] Only show selectable layers in this list Step 1: Make sure TOWN is your

Method: [c.-eate a new selection ' layer and “Create a new
"C_CODEDT" selection” is your method.
"TOT_NM_HRH"

"TOT_POP"
"M_POP™ Step 2: Double—click to add
"F_POP" “TOT_POP" to the query box.

Step 3: Click on the > sign

Step 4: Type “1000000"

[

[ Is ] [ In ] [Ngll] [Get Unigque Values | Go To:

SELECT * FROM TOWMN WHERE:
"TOT_POP" = 1000000

Step 5: Click on “Apply” to see
the results, and click “OK" when
you are finished.

Cear || Veify || Hep || Load. |

[ ok [ ey

4. You might have to zoom out a bit. You should see that the results are exactly the same as when you
selected the cities of over 1 million people in the table. It's just another way to do this.

5. To clear this select, click on the Clear Selection icon ( s ).

You can use the Select by Attribute function to select features based on any attribute value in the table.

20



Tufts Data Lab

Selecting Towns by their location relative to Railroads

Let’s say we wanted to see which towns in India have sufficient access to railroads and which towns do not, and
we want to estimate the population in each group. You can use the Select by Location function to select features

based on their spatial relationship to other layers.

1.

Turn on the Town layer and the Railway layer. Pull Railway to the top of the India Group in the Table of

Contents.

Click on Selection = Select by Location in the tools menu.

Fill out the dialog box as you see below and press OK when finished:

| Select features from one or more target layers based on their location in

| relation to the features in the source layer.

Selection method:
| |select features from

| Targetlayer(s):

[ Larage Cities
= & India
Town
[ Road
[ Railway
O Sub_District
[ State
O District
= & World
O cities
O rivers

[Jonly show selectable layers in this list

Source layer:

|f?"" Railway

Use selected features (0 features selected)

Spatial selection method for target layer feature(s):

|are within a distance of the source layer feature

Apply a search distance

About select by location oK Apply

Close

4. YouU'll see that most towns are within 5 miles of a railroad. How many people live within these selected

5. Right-click on the Towns layer and choose Open Attribute Table.

towns? Let’s find out.
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6. You will see several records are selected. Scroll to the Tot_Pop field and right click on its field name and
choose Statistics as shown below:

Table O x
H- B- R 0E
Town x
STATE_UT STATUS C_CODE01 TOT_WM_HK [ TOT . s s “m_L6] FL6 | ToT_SC [m_SC| F_sC |
Maharashtra M.Corp. |2722000042201000 2515588 11 Sart Ascending D777 (654646 585038 305821 279217
Dehi W.Corp._|0701000240103000 1965014] 98 = Sort Descending B4171(628485 | 1558147 841673 716474
Wast Bengal M.Corp._|1917000041701000 929586 4 Advanced Sorting... D2527 187755 274835150866 123969
Tamil Nadu M.Corp.|3302000040201000 952213 4 9720213620 598110 301835 286275
Kamnataka M.Corp. | 2520000042009000 g4g918| 4 Summarize... E0428|236023| 479295 244920 234375
Gujarat M.Corp._|2407000540710000 728255 365 Sratisticen |E3709[210563 | 433167 | 229430 [203737
Andhra Pradesh | M.Corp. 1000 660363 ! [ ! 269395 136013 133382
Guijarat M.Corp. | 2422000942205000 549195 2] Field Statistics 92304 | 47985 | 44318
Uttar Pradesh 1.Corp._ |0934000243405000 240400 2 Calc| e et e 283627 152242 131385
Maharashtra M.Corp._|2725000842509000 555771] 2! the selected values in this numeric 258841 152258 [146583
Rajasthan M.Corp.  |0812000841210000 403888 2 Turnl - d. This command is disabled if 293185 | 154920 138265
Uttar Pradesh M.Corp. | 0927000342705000 393005 2 Freed this field is not numeric. If any of 220035 116972103063
Maharashtra M.Corp._|2703001040919000 409945 21 the records in the table are 343031 175137 | 167834
Madhya Pradesh |M.Corp. | 2326000342606000 282586 19 X Delel currently selected, statistics will 209101 108601 [100500
Madhya Pradesh |M.Corp. 2332000243202000 28176 Mﬁf Prop only be generated for the selected 180474 | 94552| 85912
Bihar W.Corp. | 1028000342807000 230618] 1 records. 123427 | 67020 56407
Gujarat M.Corp._|2413000241909000 303130] 1411228 T 94353 | 49265 | 45088
Punjab M.Corp.|0308000440901000 268700 1398467 793142| 605325| 169273[ 93050| 76223| 183033 99814| 83119
Uttar Pradesh M.Corp. | 0915000241504000 197656 1275134| 690599| 584535 179411) 96850 82561| =274431[149718[124712
Maharashtra W.Corp._|2721000942131000 283567 1262551 675147| SG7404| 161698| 84334 77364| 57584 30117 27467
Maharashtra M.Corp. |2721001242133000 275932| 1193512| 633508| 560004 144097| 75256| 66841| 68076 35617 33359
Uttar Pradesh M.Corp. |0967000246710000 151654 1103952| 588554 515358| 163082 85220 77862| 81704 43850| 37854
Maharashtra W.Corp._|2720001142011000 225190| 1077236 575737| 501499 147919| 78579| 69340| 134451 69030 65421
Uttar Pradesh M.Corp._|0907000340711000 171142 1068772| 568081] 500691| 163570 87893 75677| 174103] 93313[ 80790
Haryana M.Corp.|0618000141902000 217647| 1055938 581069| 474869 158603| 85805| 72798| 96397 53010 43387
Andhra Pradesh _|M.Corp. | 2813002741307000 237721| 1042388 532157| 510231| 116451| 59684| 56767| 93637 47135| 46502
Uttar Pradesh M.Corp._|0945000344503000 157829| 1013092| 562864] 455228| 107211 56415| 50796| 127458 70201| 57258
Maharashtra M.Corp.|2725000742511000 231562| 1012472 547050| 465422| 143034| 75608| 67346| 140567 73416 67151
West Bengal M.Crop. |1916000041626000 211441| 1007532 547088| 460464| 94330| 48678| 45652| 48750 26463 22286
Punjab W.Corp._|0302000340205000 185858| 1003917| 538744| 465173| 121950 68461| 53489| 200937 106922 | 94015
Gujarat M.Corp. | 2409000640904000 195947 1003015| 525898] 477117| 125120| 68728 56392|  66198| 34530| 31668
Uttar Pradesh M.Corp.|0908000240912000 179947|  968256| 521026] 447230| 143046| 77884| 65162| 151484 81474| 70010
Madhya Pradesh  |M.Corp. | 2333000343913000 181886 956107 | 500952| 455155 117568 61443| 56126| 123832 | 64575| 59257
Jammu & Kashmir |M.C. 0103000340302000 130431|  952324| S17260| 435084| 91084 47407 43677 o73| 93| 44
Andhra Pradesh  |M.Corp. | 2516002141603000 210913|  945530| 479141] 466389 110671| 56206| 54385| 84007 41877| 42130
Tamil Nadu M Cnrn 33172000R41 243000 DP74RAT 930RR7 | 477937 | 4574045 QIN7N| 4RJRA| 447RR 77178 | 3R7RR| amaan| ¥
>
M4 or m = (3232 out of 3161 Selected)

7. YouU'll see descriptive statistics for the selected features, including a “sum” value of something like 246
million people. That’s our answer! But how many people don'’t live in a town within 5 miles of a
railroad?

Selgction Statistics of TOWN 4

Field

| Lo - Frequency Distribution
Statistics: Lo
Count: 3258
Minimum: 338 2000
Maimum: 11978450
Sum: 245231241 .
Mean:  75270.485267 2o
Standard Deviation: 354177 466869
Mulls: 0 1.000
Q i i ? ! i i i i T
335 ZETEEE 5157530 TIEE 1051472
1289636 Rz 6445323 aE54Y 11604020

8. Close the Statistics box. Click on the Switch Selection Icon ( Ty )at the top of the attribute table, as
shown below:
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Table
ERIL-ML [ S
Town
C_CODEDA TOT_NM_HH fTOT_PO
2722000042201000 2515588 1197348

9. All the towns that were not selected before are now selected — these are towns that are greater than 5
miles from a railroad. Right click on the Tot_Pop column to get the statistics for this group — you should
see the sum is around 40 million people.

You see that the Statistics function gives you descriptive statistics for the selected features. If no features are
selected, it gives you descriptive statistics for the entire set of features. If you clear the selection of Town (the

|

statistics for the total population living in Indian towns.

Table Options button-- " - also has a “clear selection” choice), you can click on Tot_pop and use it to see the

10. Close the statistics box, clear your selection, and close the attribute table.

Labeling a Layer Based on an Attribute Field
You can label features based on attribute values. Let’s label the States.

1. Right-click on the State Layer and choose Label Features. Note that the names for some states are
repeated — that’s because the state may have islands or other non-contiguous sections that are
represented twice in the database, and so get double names.

2. To get rid of the double names, Double-click on the State layer to access its Properties and click on the
Labels tab.

3. Click on Placement Properties and then on Remove duplicate labels, as shown below:

Genersl Source  Selection Display  Symbology Fields  Defirition Qued] Labels  Jfins & Relates Time  HTML Fopup

Label features in this layer
Method Label all the features the same way. v

Pl it Propert X
Al features wil be labeled using the optiond o OPEres

Placement ' Confiict Detection
Teat Sting Polygon Settings

Label Field: NAME

Text Symbol

[ Only place label inside polygon

@ Aways horizontal

O v gt

() Tiy horizorttal first, then straight
-

I Placement Properties

E (® Remove dupiicate labels
Flace one label per featurs

(O Place one lzbel per feature part

Conce

4. Press OK and Save your map file.
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Changing the Formatting of Labels
Let’s say you want to have the State names stand out more on the map. We can do this by changing the label’s
format.

1. Right click on the State layer name and choose Properties and click on the Labels tab.
2. Make sure that the Label field says Name.

3. You can choose the font, size and color of your labels by clicking on the Symbol... button — try making
them bold, Calibri, and 10pt font, as shown below:

Layer Properties L
| General | Source | Selection | Display | Symbolagy | Fields | Definbion Guery | Labels | Jons & Relates | Time | HTML Popup |
o Label features in thes layer
Method: [Labe! ol the features the same way -
Al features will be labeled wsing the optiona speciiad
Tt Strirg X
Label Field: NAME - Espressan. .
Text Symieal
] Calbn » 0 -
AaBb¥yZx —
. - E I u [ Symbal....
(Ctber Options Pre-defined Label Shvle
Ok || Cancel || Aoy | |

4. When you are done, return to your map. If needed, clear the previously made selection using the Clear

selection tool. |F@|T A

5. If you don’t like the results, adjust the label format again as you wish. Check out some of the predefined
label styles.

Using Large Scale Data - Kolkata
We also have more detailed (large-scale) data available for Kolkata under M:\City\Kolkata.
1. Add all the data in the Kolkata folder to your ArcMap session.

2. Group the data into a Kolkata group, as we did with the India and World data by highlighting the
datasets, right clicking, and pressing Group.

3. Zoom in on the city to get a good view of the new layers. To do so, right click on any of the Kolkata
layers and select Zoom to layer.
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4. Coloryour layers appropriately and rewrite the layer names so they are not uppercase. Make sure that

your parks are green and your water is blue. Try mapping some census attributes in the ward layer.

5. Save your mapfile!!! The next steps may crash your ArcMap session!

Using Data from ArcGIS Online

ESRI and other agencies are hosting online GIS data servers that you can access from ArcMap. We’re going to

use one of these streaming layers now.

1. Click on File = Add Data > Add Basemap.

File | Edit View Bookmarks Insert Selection Geocprocessing Customize Windows F
3 ew. i [ LT
E Open.. G0 x| @ SIME ST,
E Save Ctrl+5
Save As..
Save A Copy...
Share As 3
[ AddDate | & addData.,
B signin.. H1 Add Baserap..
HE  ArcGIs Online... B8 AddData Add Basemap
Page and Print Setup... f; Add XV D Choose a basemap from ArcGIS
'm Print Preview... Geocodin| Online. These basemaps are map |~
& rin. o adaso| St nimena” |
Export Map... sa  AddQuer] your map.
@ Analyze Map...
[“' Map Document Properties...
1 H:\ArcGl5Basics\basemap1.mxd
Exit Alt+Fd

2. Choose Imagery from the list. It will take a while to draw. Turn off the India Group Data and the World
Group Data (if it is on). A box asking whether or not you want to allow Hardware Acceleration may pop

up. If so, click yes.

-
HH Add Basemap

===

Imagery with Labels

Topographic Dark Gray Canvas

MR e i [0 7
vam, W-:"'";q_,‘m/ o NORTH
AR ATLANTIE .
FRANCE Nl P LAy LT

&l e ‘-g
| RS

National Geographic Oceans

Streets

Light Gray Canvas

Terrain with Labels

Cose ] Lo |

8

J

3. Go to File >Add Data = Add Data from ArcGIS Online. Search the World Topographic Map layer from

ArcGIS online. Click Add. This is a set up to provide a nice shaded relief background for mapping. This
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7.

will be more interesting if you are mapping the mountainous part of India — try zooming to that region

(north).

Move the World Topographic Map layer to the top of your Table of Contents.

Right click on this layer to open the Properties window, and click the Advanced tab. This allows you to
change the transparency of the layer. Set the transparency to 50%. This provides a nice shaded relief

(3d surface) background for mapping.

L%er Properties

General Source Layers Cache Advanced
Background

Transparent Color
Make the background color transparent

Make this color in the layer transparent

@ Mone

Layer Transparency

Make the entire layer transparent by this amount:

i (= E

Layer Image Format

JPEG

Cancel Apply

Remove the Basemap at the bottom of the Table of Contents. To remove a data set you don’t want, right
click on the data layer main name (e.g., Basemap) and choose Remove.

If you don’t remove it, turn off the layer for now. It makes drawing very slow.

Note that there are many other data sets available on ArcGIS Online.

Measuring Distance and Area and Drawing a Map to Scale

Measuring distances and areas

1.

Click on the Measure tool in the Tools toolbar.

@ q-+

M =

2. Click somewhere on the map to start a measuring line. Drag the line somewhere else and click again.
You will see two measurements reported in the Measurement window. The first, segment, gives the
distance (meters) of the line you just drew. The second, Length, gives the total distance. Click on a third
point in the map. You will see the new segment distance plus the total distance of both segments.

Double-click on the map to stop measuring.

Note: If you want to measure in a different unit, click on the little black triangle as shown below and select a
new distance unit:
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Measure
da + || x>
{ro measure a di Distance >

To measure an : Area >
draw a polygon.

To measure a feature, dick 'Measure A Fez
then dick a feature.

3. Try calculating the area in acres of a park in Kolkata (Go to the Kolkata Group and in the Parks Layer,
right click and press zoom to layer to guide you. You might need to turn off LANDMARK and ROAD to

Kilometers
Meters
Decirtéters
Centimeters

Millimeters

Miles

Nautical Miles
Yards

Feet

Inches

see the PARKS. Make sure PARKS is above WARD in the Table of Contents) — use the polygon tool in the

Measure tool as shown below and set the area units to acres:

Distance

= - ] -
Measure @ I

Area: 16137 Area Kilometers
Hectares
Meters

Ares

Miles
v | Acres

Feet

Yards

| 1 l

We'll learn a better way to do this later.

Drawing a map at a set scale

Many professional map users expect printed maps to be at a standardized scale. USGS topographic maps are

printed at 1:100,000 scale (1 inch on the map equals 100,000 inches in the real world or about 1.58 miles) and at
1:24,000 scale for example (1 inch on the map equals 24,000 inches in the real world, or 2000 feet or about 0.38

miles). In ArcGIS you can scale your map to any scale, but you are also offered standard scales from which to

choose.

1. Set the scale of your map to 1:10,000:

[ -

F 2l 10.000 v

1:1,000
K 1:10,000

1:24,000

1:100,000
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This is very “large scale” map (lots of detail, small area displayed) so it would work well for a map of downtown

Kolkata but not for a map of a state or the entire country.

2. Experiment with some of the other map scales. Which scale would be good for a map of downtown

Kolkata? You can also type in a scale yourself (you only have to type the denominator, e.g, 24,000, with

or without commas).

These are unitless scales. 1:24,000 means that one unit on the map (or your computer screen) equals 24,000 of

those same units in the real world. The scales provided are standard paper map scales in the United States.
1:24,000 is the map scale of the USGS topographic quadrangle maps (sometimes known as 7.5 minute maps

because they cover 7.5 minutes of latitude and longitude).

3. Try typing in 100,000 in the scale box — this creates a map at 1:100,000 scale (1 inch on the map equals

100,000 inches in the real world) and you can have a map of Kolkata.

Creating a Layout for Printing or Graphic Export

Dadra & Nagar P
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i
er O RN
e

0 2’ =0 100 Milds "
-, +
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Indian O g“rbh 2 N g\%‘ "
e

Pl

The Mumbai Large Cities

Metropolitan ° ™%*%"
Reqi & 1193512-
egion & 1508083 -

@ zro2305-

@ s

Highways

1193512 Mational Highway
1508082 ——— State Highway
2702204 ——+— Railway
4572876 *  cities

11878450

Caripgraphy: Barbara Parmenter, 1/24/12
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In order to create a printable map, you will use the layout view. It is a paper view of your data, much like
viewing the page layout when you are working in a word processing software. You should use the layout view
when you are ready to create a map — do all the preliminary work and analysis in the data view (where you have
been up to now in this tutorial).

In this tutorial, you can create a map of all or any part of India you like — we provide the graphic above of the
Mumbai Metropolitan Region as an example.

When you create a map, you should include:

e The map itself

A Descriptive Title

e Alegend

e Ascale bar (in kilometers for international data)
e A North Arrow

e Name of the cartographer (you)

e The Date & Class

e Acknowledgements of data sources.

It is important in a map not to include too much information. You would not want a map that includes all the
data layers you have in your ArcMap session from this tutorial. It would be much better to do several maps.

You may also include other elements on your map — for example, more explanatory text, labels, charts, tables,
photos, or other images.

Note that you can also have more than one data frame on a layout — for example, you can have a small
locational reference map (as in the map above) or an inset map to show an area in more detail. See the next
section (Adding a data frame to show two or more maps on a layout) for instructions about how to do this.

For detailed information about layouts, go to the main menu and click Help — ArcGIS Desktop Help. Then in the
contents bar, click on Mapping — Working with ArcMap — Using Page Layouts.

Setting up a Map Layout
1. Before you start a map layout, it is important to think through what you want to do and how you want
your map to look. What do you want to show? How large do you want your final map to be? Portrait or
landscape orientation? Do you need space for additional text or graphics? This tutorial example will
assume a printer paper size (8x11 inch) map but often you are making map for publications where they
must be smaller, or for Powerpoint where they need to be a certain size (e.g., 7.5x10 inches), or for
posters where they may be much larger than 8x11.

2. Inthe Main Menu Bar, choose View = Layout View.

3. The view changes to show your data frame on a page layout and a new toolbar appears —the Layout
toolbar.

29



Tufts Data Lab

4. The first thing you should do is to set up your Page properties. Choose File > Page and Print Setup.

5. Inthe Page Setup dialog box, make sure that the page size is set to Letter. Also check either Portrait or
Landscape (which would be better for the map you want to create? The example map is in Portrait
orientation). Press OK to return to the map.

Moving Around in the Page and Data Frame

It is very important to understand the difference between the Layout toolbar and the regular Data Frame Tools
toolbar. They share similar tools (zoom in and out, pan) but the Layout tools work on the layout as if you were
zooming in and out of the paper itself (There is paper in the icon), while the same tools on the Tools toolbar
work on the data inside the data frame (e.g., zoom into Kolkata). You will get confused occasionally, but once
you get the hang of the two toolbars, you will be off and running. For now experiment with both to see what

happens.
The Tools Toolbar The Layout Toolbar
SN JHEIRD .
& S R R oo
Use these to navigate within the
The 1:1 tool = is particularly useful to see

data frame on your map (e.g.,
you want the data frame to be
slightly more zoomed into
Kolkata, or you need to pan the

=
data frame to the north). The Zoom to Whole Page tool = will take
you back to the entire page view.

what the map features and text looks like at
actual print size.

Resizing and Moving the Data Frame

You will always need to re-size things in your map, especially the data frame itself which contains the map
image. In this case we are moving and resizing our data frame so that it fills the 4/5ths of our page (as shown
below). We'll then put a title, legend, and other map requirements in the blank space along the bottom of the

page:

Moving and re-sizing in ArcMap works similarly to most other programs where you use graphics. The key is
selecting the element first. The steps for this are on the next page.

R

1. Toresize and move the data frame, use the Select Elements pointer to select the frame first.
2. Use the small grab points on the corners and sides to resize.
3. Click and drag with the cursor anywhere over the data frame to move it.

4. To move the actual map within the page, use the pan hand in the data frame tools.
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“Printable” Page
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Inserting a Title, North Arrow, Scale Bar and Legend
These are all required elements on all maps. You access them by going to the Insert item on the main menu bar.

You can read more about these by going to Help = ArcGIS Desktop Help. Then, in the contents bar, click
Professional Library = Mapping and Visualization = Page Layouts.

Use the Insert menu function to insert a Title and a North Arrow. Place them in the bottom, empty part of your
map layout.
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Insert Scale Bar
Insert a scale bar of your choice. You may wish to change the units of the scale bar you select. If you want a
different unit, double-click on the scale bar. In the Scale and Units tab, select a different Division Unit (Kilometers

for International Data!). You can expand the scale bar using the corner nodes. Make sure it ends on an even and
easy to read number (eg. 4 Km instead of 4.5 Km).

Insert Legend
There are lots of ways to improve your legend. For starters, let’s say we’re creating a map of Larger Cities in
India. We want the legend and map to focus on large cities. We have features in the background as in the

example map, but everyone knows what that is, it doesn’t have to be identified in the legend. To control what
goes on the legend:

1. Choose Insert 2 Legend from the main menu.

2. Adjust what is in the legend so that only Large Cities is there by following the graphic below. You may
need to select Large Cities from the Map Layers box, and then use the arrow to manually add it.

Legend Wizard x

to include in your legend

Select
Ewverything
here except

Large Cities r-

- Railway
- Sub_District

Legend tems

LaEe Cities *

Click here to take all the
Layers except Large
Cifies Out of the Legend

Experiment with the

< Back Next > Cancel

3. Once your layers are ready, click on the Next tab.

4. Then, you can modify the legend. For example in the Legend Title, you can tell it NOT to show the word
“Legend” by erasing it or you can change that word to something else.
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Legend Wizard [}

Legend Title
Legend

Legend Title fort p

You can choose your title for

your legend by typing it here.
Color:

is to
Size: |24

cantrol the justification
e of the title with the rest
of the legend.
Fort: |,0] Aial v
B 7 U ====
Preview
< Back Next > Cancel

5. You can adjust all the attributes in each window, as desired. When you click Finish, the legend will
appear. You can drag to put in the location you want it.

Note: make sure Large Cities is checked in the Table of Contents, or else the legend will be blank.

6. Double click on the legend to access and modify its properties.

Click on the General tab, and create a title for the legend called Cities Population. You can change its
properties (font, size, etc) by clicking on symbol...

Leg er{/\\i’ Properties

X
General fems Layout Frame  Size and Position
Title

‘ Cities Population|

Show

Symbal...
Specify Legend Items
Map Layers:

Legend Items:
. Citations

. R
B-Kolkata

i Landmark

E| India

Map Connection

Only display layers that are checked on in the Table Of Cantents
Add a new item to the legend when a new layer is added to the map
Reorder the legend items when the map layers are reordered

[ 5cale symbols when a reference scale is set

Conce | | fosly

8. Go the Items tab, then click on Style:
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Lel:\g;nd Properties

General ftems  |layout Frame
Apply settings to selected item(s)

Select All Select None

Style...

Size and Position

Fant
Apply to &l labels

Map Extent Options
[C] only show dasses that are visble in the current map extent

[ 5how feature count

r
L

Show thousands separator

Use currentindex feature as the map extent {data driven pages)

Item Columns

[Place item(s) in a new column

Column count for item(s) 12

oK Cancel

Apply

Try out different styles and preview how they will look.

Legend ltem Selector

Layer Name
- Drescription

Preview

Horizantal Single Symbol
Description Only

Properties...
Horizortal Single Symbol Horizortal Single Symbaol
Label Crily Layer Name and Description More Styles
Save... Reset
Layer Name Heading

: =

10. Press OK, and OK again. If the map goes back to one column and you want two, double-click on the

Legend again and under the Items tab, type in 2 for columns. There are lots of things you can edit in the

Legend Properties. Explore the different tabs to see all the options.
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Selecting Elements
Remember, you always have to select an element before you can move, resize, or change its properties. Use the

K

CTRL key as you click on each element.

select pointer icon on the Tools Toolbars. You can select more than one element by holding down the

Modifying an element after insertion
You can usually modify an element after you have inserted it by selecting it and then double-clicking on it. The
relevant dialog box will appear for that element (e.g., title, legend, scale bar).

Inserting text

To include your name as the cartographer, and any other information, use the Insert > Text function.
Remember also to include a date. You should also have a data source - note that the data comes from the Tufts
GIS M Drive (For later tutorials, it will need to be more specific).

Add more text for any more descriptions or explanation of your map.

You can change font properties on selected text by right-clicking on the selected text and choosing Properties
then Change Symbol.

Inserting a Picture
Note that you can also insert images into the data frame.

Deleting and Trying Again

If modifying an existing element doesn't work, remember that you can always select an item and delete it if you
don't like it. Select it using the select pointer, and press delete. Especially useful if your legend gets messed up -
just delete and insert a new legend again to start fresh.

Saving Map Files under Different Names
Once you have created one map in a layout you like, you can save your map file (File = Save As) to be the name
of that map (e.g., Larger Cities India). You can then use the same layout but change some of the visible features
and save as a new map name (e.g., India Cultivators).

This allows you to make maps fast once you have a good layout, and it allows you to make maps of the same
area at the same scale, but showing different layers of information.

Choose File->Save As and save the map file to an appropriate new name.

Adding a Second Data Frame to Show an Inset Map

You can add a second (or more) data frame to your ArcMap session. Only one data frame will appear at a time in
data view (right-click on the data frame name and choose Activate to see the data frame you want). But in
layout view, all the data frames will appear. This can be handy for putting in a small "locator" map. See the
following graphic:
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Data frame for main
map

Data frame for
location map

Sangakre Chennal

Cities Population

e 1003015- 1193512
1193513 - 1506062
& 1508083 - 2702304
@ 2702305 - 4572876
@ 4572877- 11978450

Adding a Second Data Frame for a Locator Map

Multiple data frames can get a little tricky, and will take some practice. Play with them some, and remember to
save map files frequently under different names in case you mess up and want to return to a previous view. In
this example, we’ll use a new data frame to insert a locator map.

1. In Layout View, choose Insert = Data Frame from the top main menu. A new data frame box appears in
your layout. You’ll see the New Data Frame listed in the table of contents:

= [ rivers

= lakes

= countries
[
O World_Imagery
[0 World_Shaded_Relief,

= MNew Data Frame

-—g

2. Move and resize the new data frame box so it is in the location you want it — here we are taking it to the
bottom right corner of our layout:

Move and resize your new
data frame where you want
your locator map

Cities Population

+  1003015- 1193512
1193513 - 1506062
1506063 - 2702304
2702305 - 4572876
4572877 - 11973450

o New Data Frame |°

Q&= .

3. You can add data to this data frame just as you did to the first one, or in the Table of Contents, you can
drag a layer from the first frame to the second. Try dragging the Countries layer from the original data
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frame down to the New Data Frame and turn it on.

= = New Data Frame
= countries
]

4. Drag the State layer (in your India group layer) down as well, or drag it from the ArcCatalog window -

M:\country\India\India Base Map\

Note: If you drag it down from the above data frame, you may need to turn off data labels.

5. Zoom to India by drawing a square around India using the magnifying glass.

6. Make sure to drag the state boundaries above the Countries. Countries should be white with a gray

outline.

7. Set the State fill color however you wish with no outline so you will highlight India boundaries.

8. Inthe table of contents, right-click on New Data Frame and choose Properties.

9. Click on the Frame tab and change the Background color to blue — this will make the water appear blue.

DatL\\Ferame Properties X

General Data Frame Coordinate System Grds
Feature Cache Annotation Groups BExtent Indicators Frame Size and Postion

Baorder

’—v : Colpf® (N |-
Gap XI:: pts Y I:: pts nding: Ij: %

Background

Color: -

: o
pts Y Ij: pts  Rounding: Ij: %

Flenr Chodnn

10. Press OK to see the results. Save your map file!

Setting up Locator Map Boundary Box

Finally, we’re going to show a boundary box on our Locator Map.

1. Right-click on the new data frame to get its Properties dialog box back.

2. Click on Extent Indicators tab and follow the instructions below, then press OK:

l}ata Frame Properties *

General Data Frame Coordinate System lllumination Grids
Feature Cache Annotation Groups Extert Indicators Frame Size and Position

Yfou can add one or more extent indicators to this data frame. Each indicator
shows the extent of the data in one of the other data frames and automatically
updates if the extent changes.

Show extent indicator for these data
Other data frames: frames:

>>.“"\! "
Highlight Layers (your

original data frame) and
click on = then press

OK. This will show the
extent of the Layers’

data frame in your data

frame

Options l_ J
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Note that the extent of your main map will be outlined in the smaller map; if you do not like the extent of the

box that you just created, use the pan and zoom tools on your larger map to adjust. If all this was successful,

save your map file! Otherwise delete and try again.

Work as necessary on your layout to make it show what you want it to show — choose a variable for Kolkata or

for the State data or by District or Sub-district. Show the location with a locator map.

Printing or Exporting your Map
You can print directly from ArcMap or you can export to a digital graphic format like .pdf. Printing works just like

any other Windows program, so we won'’t cover that here, but feel free to print your map. We will talk more

about printing options and good resolution in class.

The ability to export to a digital format is very useful. If exporting to an image, remember to set your page size

to the appropriate dimensions - this may mean custom dimensions, e.g., a small image to fit on a computer

screen, a powerpoint presentation, a web site, or word document. When creating a layout for digital export, you

should think ahead about what size you want your final image and lay out the map accordingly, and be sure to

use font sizes that are readable at the final map size.

1.
2.

When you have your layout the way you want it, choose File = Export Map.
In the Export dialog box that appears, navigate to your tutorial folder and give the image a name.

For Save as Type, choose a format - we recommend .gif or .pdf because they come out well and are
readable across a variety of platforms. The only problem with PDF formats is that they do not import
well into Microsoft publisher and they do not recognize all text fonts.

Before you export, adjust resolution under the Options area. Digital images meant to be seen on a
computer screen do not need high resolution. 96 or 150 should be fine depending on image size, 300
should be the maximum.

Press Save when you are ready to go - the process will take a minute.

Check your results by navigating to the folder outside of ArcGIS and opening the graphic - if you're not
pleased, experiment with different resolutions and compare file sizes.

That's the basics. Now practice what you have learned by creating several maps of India, a region within India,

Kolkata, or the West Bengal.

Below are two example maps:
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Female Population, 2011 ‘L .,
Kolkata, India '/:1/
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Percentage of Female Population by Ward

B & ) & Y Catherine Ressijac
DHP P207

January 19, 2018

Data Source: India Census, M Drive
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By District
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Male Cultivators in India, 2001

Carolyn Talmadge, GIS Specialist
MCM591
September 2, 2016
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